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SESSION DESCRIPTION 

Wondering if the "Revit-olution" and Building Information Modeling have anything to offer interior 
design firms? Well, wonder no more. The answer is yes! In this session we will explore how you can use 
Revit Architecture to help you explore, create, and document an interior design project. Part "case 
study" and part "how to," this session will walk through a space designed by an interior designer and 
realized in Revit Architecture. We will learn how to build basic elements in Revit® like walls, doors and 
glass partitions. We will explore incorporating design sketches and DWG files into the workflow. We'll 
take a brief look at Design Options, Color Fill plans, Area calculations, Perspective views, Walkthroughs, 
detailed Schedules, Material lists and more! We don’t have much time, so grab a seat and let's get 
started. 
 
Learning Objectives 

1. Explore an Interior Design workflow in Revit 
2. Understand wall types, filters and tags 
3. Create finish plans and color fill diagrams 
4. See how schedules enhance workflow 

 
About the Speakers 
 

Paul F. Aubin, Paul F. Aubin Consulting Services 
 

Paul F. Aubin is the author of many CAD and BIM book titles including the widely 
acclaimed: The Aubin Academy Mastering Series: Revit Architecture, AutoCAD 
Architecture, AutoCAD MEP and Revit MEP titles. Paul has also authored several 
video training courses for lynda.com (www.lynda.com/paulaubin). Paul is an 
independent architectural consultant who travels internationally providing Revit® 
Architecture and AutoCAD® Architecture implementation, training, and support 
services. Paul’s involvement in the architectural profession spans over 20 years, 
with experience that includes design, production, CAD management, 
mentoring, coaching and training. He is an active member of the Autodesk 
user community, and has been a top-rated speaker at Autodesk University 
(Autodesk’s annual user convention) for many years. Paul has also 
received high ratings at the Revit Technology Conference (RTC) in both the 
US and Australia and he spoke at the inaugural Central States Revit 
Workshop last year. His diverse experience in architectural firms, as a CAD manager, and as an educator gives 
his writing and his classroom instruction a fresh and credible focus. Paul is an associate member of the 
American Institute of Architects. He lives in Chicago with his wife and three children. 

Contact me directly from the contact form at my website: www.paulaubin.com 
Follow me on Twitter: @ @paulfaubin 
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Introduction  
If you are involved in Interior Architecture or Interior Design and are considering the use of Revit in your 
practice, then you have come to the right place. In this class, we will explore many of the features and 
benefits of Revit Architecture for interiors projects. There are many entry points to adding Revit to your 
existing workflow. The most important thing to realize is that you can take it slowly and implement the 
features that matter most to your practice as project needs dictate and business cases develop. 
Whether you are interested simply in creating more tightly coordinated construction document sets or 
wish to implement Building Information Modeling (BIM) into your practice, Revit has something to offer. 
In the topics that follow, several tips will be presented for ways to achieve common task required by 
interior design using Revit Architecture.  

Note: I chose the name “Revit Inside” for this class as a play on words; with the “inside” referring to 
interiors. There is also a website names Revit Inside that provides a listing of firms that use Revit. You can 
find the site at: http://www.revitinside.com/. Perhaps one of your competitors is on the list?  

Getting Started 
If you have not yet begun using Revit, then a few obvious questions typically are at the top of the list: 
Why should we use Revit? How do we get started? Is Revit hard to learn? What benefits will we see? 
Can we use Revit with AutoCAD files? And many more. This paper will try to address many of these 
questions and more. For an answer to “why” we should use Revit, there are many potential answers, but 
consider my favorite Revit feature: The Project Browser (see Figure 1).  

 
Figure 1 – Select and edit in one view affects all views automatically 

2 

    CENTRAL STATES REVIT WORKSHOP 2012 
 



 
 

In Revit, you create a single virtual model of your project. Revit allows you to view this model in a variety 
of ways including: floor plans, elevations, sections, ceiling plans, details, 3D views and schedules. 
Further, you can edit the model from any view and changes automatically appear in all other views. 
Since there is a single model that is simply displayed as a plan, section, schedule or 3D a change to one 
view is a change to all. Views cannot get out of synch. By itself, this feature alone can be enough to 
justify using Revit over more traditional approaches where there are dozens of disconnected drawings 
that represent the same portions of the project and must be manually coordinated.  

So if you are new to Revit, this is definitely the place to start. The easiest way to get started with this 
feature is to open an existing Revit project, open several views onscreen and make some simple edits. 
Move a door in plan for example and watch it move in elevation. Type a new name in a Room Schedule 
and watch the tag in the floor and ceiling plans update. Delete an element from one view and watch it 
disappear in all others. The easiest way to conceptualize this concept is to think of the actual finished 
building. Even though you might draw a door several times in your documents: once in plan, once 
elevation, again in schedule, there is really only one door in the actual building. If this door changes size, 
location or is removed, it affects only one “real” door, but in traditional procedures, several edits would 
be required. In Revit, it is built in the Revit model as it is in real life: one real door, one Revit door. 
Simple.  

Basic Building Elements  
Walls, Doors, Rooms and Ceilings offer the basic building blocks for many projects. In addition, you can 
add furniture, casework and equipment and even build specialty items like glass partitions. Revit offers 
tools for each of these components. Draw walls in plan by designating overall parameters like height and 
wall type and draw by picking start and end points. Walls can be straight lines or arc curves. Doors 
automatically cut holes in Walls. Ceilings find the shape of surrounding Walls automatically or you can 
draw custom shaped ceilings in any shape you require. Equipment, furniture and casework items are 
placed from a library of content provided with the software or you can locate additional items online at 
various content provider websites or build your own.  
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Figure 2 – Various model elements shown in section 

There are the obvious benefits of using such objects. For example, rather than draw two parallel lines 
for each wall, a single Wall element is drawn. When two Revit Walls intersect, they join automatically 
creating clean intersections with the additional trimming required of individual lines in CAD. When you 
place Doors, they cut holes in the host Walls, Railings, Floors and Ceilings can all be easily derived from 
surrounding geometry with little additional effort. Some of these benefits were already noted.  

Design sketches and DWG files 
So at a high level, just considering project browser and the single building model with its multiple views 
and the enhanced productivity of using Revit building elements to create your building model we 
already have some compelling reasons to consider Revit for our next project. So the next question is 
likely when should we add Revit to the process? Should the project be begun immediately in Revit, or 
should it be transitioned there after some preliminary work in other programs? Naturally the answer 
depends. If you have a team of experienced Revit users, you can begin right away in Revit without the 
need to start in other software first. If the team is new to Revit, there is usually a productivity dip before 
people get up to speed with the Revit process. At the early phases of a project, the budget may not be 
able to absorb the associated costs of the learning curve.  

Even with an experienced team, sometimes folks will prefer to work in other design tools in schematic 
design. These might include AutoCAD, SketchUp or other 2D and 3D design packages. Furthermore, 
many building owners and clients will provide base building information as 2D CAD files often in DWG 
format. Revit can import CAD files and many popular raster file formats. If you receive such a file, do not 
feel compelled to trace or otherwise “Revitize” this background file. It is possible to import the 
background file as is and work in Revit directly on top of the file without editing it or converting it. The 
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specific needs of the project will largely dictate the appropriate course of action. If editing of the 
background is required (if renovation of an existing space is part of the scope for example), you will have 
to weigh the pros and cons of converting the CAD file to Revit vs. performing the necessary edits directly in CAD.  

It is possible to begin using Revit at nearly any phase of the project. Naturally, the earlier that you 
incorporate Revit into the team’s workflow, the less potential there is that rework will be required. 
Regardless of the phase when you begin using Revit, keep the following in mind with respect to CAD files 
used in Revit projects: 

CAD files can be imported or linked. An imported file is embedded in the Revit project and cannot be 
updated if the original CAD file is modified. This is usually the preferred way to bring details into Revit. 
Linked files maintain a connection to the original CAD file. If the file changes, Revit will load the latest 
version the next time the project is opened. This is typically the preferred approach for background files, 
particularly if work is being conducted in CAD concurrently to Revit (see Figure 3).  

 
Figure 3 – Link CAD and Import CAD buttons are found on the Import tab 

If you Import a CAD file: Do not explode! Exploded CAD files bloat your Revit project file size and create 
many unnecessary line styles, materials and other project settings and standards that can be difficult to 
manage and/or purge. If editing of the CAD file is required, it is much cleaner to edit the file in the 
original application and then re-import it into Revit.  

If you Link a CAD file: You cannot explode a linked file, so this is not a concern when linking. Use the 
Manage Links dialog (Insert tab, Link panel) to modify the settings of the linked file and to reload it 
during your Revit session. You can also unload it and convert it to an Import with the Import button (this 
breaks the link). 

Pay attention to the various settings at the bottom of the “Link or Import CAD Files” dialog. Several 
options are available when you link and import CAD files.  

Current View Only: This checkbox determines if the CAD file will behave like model or detail geometry in 
Revit. If you leave this box unchecked, the CAD file will appear in all views (behaving essentially like 
Model Lines). If you check this box, the CAD file will appear only in the current view (behaving essentially 
like drafting lines). If you have a CAD file for each floor of a building, you will probably want to check 
Current view only. If you have a base building file that is the same on multiple floors, you will want to 
clear the checkbox so that it will appear on all views. If you need it in some views, but not all, you will 
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need to clear the Current view only checkbox and then hide it individually in views that don’t require it. 
You can use the “Visibility/Graphic” overrides dialog to hide it, or use the Hide tool on the ribbon.  

Colors: settings include preserve, invert and black and white. AutoCAD typically uses a black background 
and Revit typically a white one. If you want to show and print the CAD file in color, Invert is a good 
choice since the AutoCAD primary colors may not read too well on a white background. Invert (or 
preserve) are good choices if you are tracing the background. Having the color display onscreen will 
make it easier to see when you have finished tracing the lines in the file.  

If you plan to print the file from Revit, use Black and White.  

 
Figure 4 – Link a CAD file 

Positioning: Many options are available. Common wisdom would dictate favoring the Origin to Origin 
option. However, the way that Revit manages coordinates is different than AutoCAD, so this may not be 
all that necessary in most Revit projects. Whichever option you choose, you can save the coordinates in 
a “shared coordinate” system after linking the file. Consult the online help for more information on 
Shared Coordinates.  

Tracing a CAD File 
If you find you need to “convert” a CAD file to a Revit model, unfortunately there is no automated way 
to do this. Tracing the underlying CAD file is your only option. However, Revit is very smart about 
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interpreting the CAD file. For example, Figure 5 shows that Revit will find the centerline between two 
lines in the CAD file as you trace with the Wall tool. This will speed the task of tracing the file.  

 
Figure 5 – Tracing a CAD file with Walls 

Design Options 
Creating design schemes with traditional design tools would typically require that multiple copies of 
each drawing or model be created and maintained. With the Design Options feature in Revit 
Architecture, you can maintain a single model that contains one or more schemes within it. With this 
methodology, you can explore and present multiple design possibilities while avoiding much of the 
repetition and duplication of traditional procedures. Furthermore, Revit’s fully coordinated building 
information model is maintained and updated “on-the-fly” accurately representing each scheme as 
various Design Options are made current.  

The Design Options feature (see Figure 6) gives you a flexible way to create, manage, and present 
alternate design proposals. Using one or more “Option Sets” each containing various “Options,” you are 
able to manage variations in your design that deviate from the “Main Model.” You can present each 
option independently in separate Revit views and sheets including Schedules that will accurately reflect 
the active option.  

 
Figure 6 – Access Design Options on the Status Bar or Manage tab 
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The following are some basic definitions of common terminology used in conjunction with the Design 
Options functionality.  

Main Model—This term is used to describe any part of your Revit design that has no variation under 
consideration. In other words it does not have any Design Options associated with it. Before you add 
Design Options to a project, everything is part of the Main Model. Once you begin adding Options, you 
can move elements from the Main Model to one or more Options.  

Option Set—Each work area or portion of a project to which you will consider design variations will 
become an Option Set. For example if you wanted to consider variations for the entrance to your 
building, you might create an Option Set called “Main Entry.” To this set, you could add an “Option” for 
each variation you wish to consider.  

Option—Each Option Set will contain at least one Option, but to be meaningful, you should include at 
least two Options. An Option represents a discreet design variation you wish to consider in your project. 
For example, if you had a “Main Entry” Option Set as suggested above, you might have two Options 
within it called “Single Door Entry” and “Double Door Entry.” Each Option would show the appropriate 
geometry to represent the design intent of that Option. Both options would contain a copy of the Wall 
that hosts the Door variations.  

Primary—The Primary Option is simply the Option that you or your client favors. It is the most likely to 
be accepted and implemented in the final design. When you make an Option Primary, all views in the 
project will update to reflect the change. You do not need to make an Option Primary to edit it. In fact, 
making an Option Primary is typically done late in the process as a step in the process of accepting an 
Option and removing others from consideration (see below).  

Accept Primary—This function merges the Primary Option in a Set back into the Main Model and 
permanently removes all others from the project.  

 
Figure 7 – Before you can begin you must add at least one Option Set and Option 

The Design Options toolset is intended as a means to manage the design variations (schemes) under 
consideration. As such, it is assumed that at some point in the design process, one of the Options will be 
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chosen over the others. The Design Options tool is therefore meant to be temporary. While you could 
maintain more than one Option indefinitely, the intent of the tool is that one of the Options under 
consideration will ultimately prevail. The tools will be most successful when used in conjunction with the 
workflow described herein. However, like many aspects of architectural practice, procedures and 
workflows can and often do vary from firm to firm and even project to project within the same firm. 
Therefore, while the intention of Design Options toolset follows a narrow scope and focus, you will find 
that with a little creativity, it can be used successfully even when deviating from its “intended workflow.”  

The basic procedure for Design Options is as follows:  

 Create an Option Set containing two or more Options.  

 Add geometry to each Option.  

 Create views (in Project Browser) with Design Option overrides applied to present each scheme. 

 Upon approval by your client, make an Option Primary and then “accept” the Primary. 

Area Calculations 
For basic square footage calculations, you can query the area of the Room elements in your project. 
Rooms provide basic “finished” area, volume and simple finish designations (see below). Also, Rooms 
report the name and number for tags and schedules. For more control over square footage calculations, 
Revit has a special floor plan type called and Area Plan. Area Plans use Area Boundary lines and Area 
elements to define areas and calculate their values very precisely (see Figure 8).  

 
Figure 8 – Creating an Area Plan 
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The basic procedure for creating an Area Plan is as follows: 

 On the Home tab, on the Room & Area panel, click the Area tool and choose Area Plan.  

 In the “New Area Plan” dialog, choose the Type of Area plan (Rentable or Gross Building), the floor 
level and the scale and then click OK.  

 You will be prompted to automatically create boundary lines. If you answer yes, Revit will attempt to 
determine the location of the area boundaries (center of wall, face of glass, etc) based on the rules 
built into the system. Consult the online help for more information. You can always override any 
automatically generated boundary lines by adding your own manually and/or adjusting the 
automatically created ones. 

 Click the Area tool again and choose Area Boundary Line to add additional boundary lines. Your goal 
is to enclose each region that you wish to measure.  

 Once all Area Boundaries are placed, use the Area tool to add Areas. Simply click in an enclosed 
region to add the Area. Optionally rename them.  

 Generate a schedule to see a list of all areas with their values.  

There are two schemes included in the out-of-the-box 
templates. Gross Building Area and Rentable. Gross Building 
Area will automatically generate Area Boundary Lines to 
the outside edge of exterior Walls, while Rentable will look 
at adjacencies and inserts in Walls to determine if lines 
should be placed at the face or center of the Wall or at the 
face of glazing. After you add Area elements, you can select 
them and edit their properties. The Area Type parameter is 
useful to define each Area within a set list of types. For the 
Gross Building Area scheme, two Area Type values are 
provided: Gross Building Area and Exterior Area. For the 
Rentable scheme, Area Type values include: Building 
Common Area, Office Area, Exterior Area, Floor Area, Major 
Vertical Penetration and Store Area (see Figure 9). Add the 
Area Type field to a schedule to sort or sub-total based on 
the function of an Area. The values in the Area Type list are 
fixed in the software and cannot be edited directly.  

Each type of Area Plan will create a separate branch on the Project Browser. If you need to calculate the 
areas on a particular plan more than one way, you can create another Area Plan type. On the Home tab, 
click to expand the Room & Area panel and then click the Area and Volume Calculations button. On the 

 
Figure 9 – Assign Areas to an Area Type 
to make scheduling and reporting more 
accurate 
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Area Schemes tab, you can click New to create another scheme. This will allow you to create a new Area 
Plan with alternate boundaries, Areas and schedules.  

Color Schemes 
Color schemes can be applied to plan, section and elevation views and apply colors and patterns to 
Rooms or Areas based upon a particular rule. Any parameter of a Room or Area object can be used as a 
criterion for the color scheme. For example, if you have assigned each of your Area elements (from the 
previous tip) to an Area Type, you can create a Color Scheme that displays Building Common Area in one 
color, Office Areas in another color and so on. You can even add a legend to the view that defines each 
possible color or pattern used in the view. Color Schemes provide an effective way to display useful 
information in a graphical way.  

To create a color scheme, be sure you have either Rooms or Areas in a view and open that view 
onscreen.  

 On the Home tab, click the Room & Area panel to expand it and then click the Color Schemes tool.  

 From the Category list at the left, choose either Rooms or one of your Area Schemes as appropriate. 
(Only Area Schemes for which you have created Area Plans will appear in the list).  

 Beneath Category, a Scheme will be suggested. You can use this one, or use the icons at the bottom 
to duplicate it and create a new one. Each Scheme can only apply to one parameter at a time, so if 
you wish to theme by Area Type and Area, you will need to create two schemes and apply them to 
different views.  

 On the right side, input a title and then choose what parameter will be used from the Color list. A 
collection of colors will appear automatically based on the elements appearing in the model in the 
current view.  

 Edit the color or pattern of any of the items if you wish and then click OK.  

 To apply the Scheme to a View, edit the View Properties and choose it for the Color Scheme 
property. There is a Legend button on the ribbon if you wish to add a legend to the view (see Figure 10).  
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Figure 10 – Create a Color Scheme and apply it to a view 

You can create as many Color Schemes as you wish in a project. However, you can only apply one 
scheme to a view at a time. To display the same view using different schemes, duplicate the View first 
and then apply different schemes to each one.  

Finishes 
Designating finishes is a big part of an interior design project. In this area, Revit offers a few possibilities. 
The simplest way to designate and report your finishes is using Rooms and a Room Schedule. This is 
effective when the finishes in each room are simple and do not vary from surface to surface (the entire 
Room uses PT-1 for example). Room objects have simple text fields for inputting finishes. The default 
project template includes a field for Wall, Base, Floor and Ceiling finishes. To use this functionality, add 
Rooms, edit the Room’s properties and fill in the values for Floor Finish, Wall Finish, etc. Create a Room 
Finish Schedule that reports these fields.  

For spaces with more detailed designs and multiple finishes 
per surface, an alternate solution is required. Revit offers a 
few alternatives for such cases: 

Modeling—For the sake of completeness, it should be noted 
that you could choose to model all surface changes. This 
would require splitting Walls, Floors and Ceilings into multiple 
elements, and then creating and assigning materials to each 
such element. Theoretically this approach would maximize the 
amount of data you could extract from your model, and some 
might argue was a more “accurate” rendition of the true 

 
Figure 11 – Just because you can, 
doesn’t mean you should. Always keep 
the effort vs. benefit analysis in mind as 
you make project decisions 
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conditions that would ultimately be built. However, the amount of additional effort required to build 
such a model would make such an approach impractical. Further a model built this way would be more 
difficult to maintain as the project progressed. With each decision you make in a project, be sure to 
carefully weigh the effort required to complete a task with the expected benefits of performing the task. 
The amount of effort expended should not exceed the benefits gained.  

Split Face—Another approach is the Split Face tool. With this tool, you can split the surface of a model 
element into two or more distinct regions. On the Modify tab, on the Edit Face panel, click the Split Face 
tool and then select a face of a single model element such as a Wall or Floor. This will enable sketch 
tools and allow you to sketch the shape of the split face. Once you have completed the sketch, use the 
Paint tool to apply a different Material to the Split Face. Revit will literally paint the material onto the 
surface in this region. Unlike the modeling approach, the structure of the element will be unaffected by 
Split Face and Paint. However, painted Materials will appear in schedules and you can even tag them 
with Material tags (see Figure 12 ).  

 
Figure 12 – Use Split Face and Paint to apply finishes to the surfaces of your model 

To schedule materials, you create a Material Takeoff. This is simply a schedule that can report on the 
Material properties of elements in your model. To limit this takeoff to just Materials that are finishes, 
add a prefix in front of each of the material names you wish to include on your finish schedule. Then use 
the filter option in the schedule to include only Materials whose name begins with the prefix you 
designate (see Figure 13).  
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Figure 13 – Creating a Material Takeoff with a filter for just “Finishes” yields a finish list 

Finish plans—You can do Finish Plans the same way. Simply use the Split Face and Paint tools on the 
Floor element in a plan view.  

Finish schedules—As noted, use a Material Takeoff for a Finish Schedule. When you first create it, 
decide if you want a single material list for the entire project, or want separate lists for Walls and Floors. 
If you want a single list, use the <Multi-Category> option when you create the Material Takeoff. If you 
wish to have a separate Wall or Floor finish list, you can choose the appropriate category instead (see 
Figure 14).  

 
Figure 14 – Understanding the properties of a Material Takeoff 

On the Fields tab, the only difference between a Material Takeoff and regular Schedule is the availability 
of “Material” fields for the Material Takeoff. Material fields are prefixed with “Material:” When you 
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select one of these fields, you are instructing Revit to give you the information about the Material 
instead of the object to which the Material is assigned. You can tell Materials that have been “painted” 
onto a surface in the schedule if you include the Material: Volume field. The volume of painted Materials 
will be zero. You can also use the Material: As Paint field specifically to identify those that are painted.  

Generic Annotation Symbols 
The methods above give effective ways to create a Finish Schedule or Material Reference List. However, 
it may not always be practical even to use Split Face and Paint. Therefore, what can you do when you 
wish to simply callout material designations on a drawing without changing the model in any way? Can 
this even be done in Building Information Modeling and Revit? Well, it certainly can be done. The more 
important question of “should it be done?” is one you should consider carefully. The Split and Paint 
approach is effective and requires about the same amount of effort to which folks are already 
accustomed. It can be argued that it is slightly more effort, as the sketched split regions must make 
enclosed shapes in order to be painted and each element must be selected to use the tool and in some 
cases, making those selections will be challenging and might require additional views to be created. 
Furthermore, each Material must be defined in the “Materials” dialog. However, the benefit of the 
approach is that it is applied to the model and will therefore appear in all views and we can even 
capture the area of painted Materials giving us a useful tool to make simply quantity takeoffs. Despite 
these potential benefits, in your own effort/benefit analysis, you may decide that these benefits do not 
justify any additional effort.  

If you would prefer to simply sketch lines on the views to indicate finish transitions and call them out 
with simply symbols, we can do this in Revit too! This is actually easy to do except for some unfortunate 
terminology obstacles. In Revit, a Generic Annotation Family is a simple 2D symbol. It can optionally 
have parameters (fields) in which we can input values. (If you are familiar with AutoCAD, it is like a block 
with attributes). The first terminology obstacle is this: Generic Annotation and Symbol mean the same 
thing in Revit. Generic Annotation is the kind of Family and Symbol is the tool used to insert them in a 
project. Said another way, you use the Symbol tool to insert Generic Annotation Families and to create 
“symbols” you use the Generic Annotation Family template. Clear as mud?  

Symbols (Generic Annotations) are 2D annotation and like other 2D annotations appear only in the view 
to which they are added. Let’s assume that you wanted to add finish designations to a plan or interior 
elevation. Simply draft with Detail Lines any transitions between finishes and then add a Generic 
Annotation Symbol to call out the finishes. To input the finish value, you just click on the Symbol and 
edit the value. Keep in mind that Symbols like this are not linked to anything in the model. So this is not 
very “BIM” like, but may in fact be perfectly suitable for the task at hand. Despite this possible 
limitation, there is one important upside. We can create a Schedule of all Generic Annotation Symbols 
that report all of the values input into the symbols! To create such a Schedule, you must learn the 
second terminology obstacle. A Generic Annotation (Symbol) Schedule is called a Note Block. Said 
another way, a Note Block will list all instances of your Generic Annotation symbols and their associated 
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values! So, even though the solution is not very “BIM-like” it is still more effective and powerful than 
what we are used to with traditional methods. Let’s walk through the steps:  

Goal: Create a Finish Symbol with finish designation displayed and hidden fields for other values and 
then report all instances of this symbol on a Schedule.  

 From the Application Menu (big “R”), choose New > Annotation Symbol. In the “New Annotation 
Symbol” dialog, choose the Generic Annotaiton.rft template and click Open.  

 Delete the red note. Draw a simple symbol using the Line tool. It can be any shape you like and 
should be drawn centered on the two reference planes onscreen. Draw it the size it will be on paper 
when printed (13/32″x5/32″ for example).  

 On the Create tab, click the Label tool (a Label is a piece of text that references a parameter so that 
you will be able to edit the value in the project). Click in the middle of the screen to place it.  

 The “Edit Label” dialog will appear. Since this is Generic Annotation, there are no predefined 
parameters. We can add any we wish to include in our final Finish Schedule. Click the Add Parameter 
icon (bottom left). In the “Parameter Properties” dialog, type Finish Code for the name and choose 
Instance and then click OK.  

 Add other Parameters if you like, such as Description, Model Number or Cost. Set them all as 
Instance. 

 Select Finish Code and then click the Add Parameter to Label icon in the middle. Change the Sample 
Value to something like X-1 and then click OK (see Figure 15).  

 
Figure 15 – Create Parameters and add the Code to the Label 

 Save the Family file and then on the ribbon, click the Load into Project button.  

 In the project, place a few instances of the Symbol. When you first load it into the project, the tool 
will already be active. You can cancel the command if you are not in the correct view. To get back to 
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the command, remember, a Generic Annotation Family is actually a Symbol. On the Annotate tab, 
click the Symbol tool. Use the Detail Line tool to draw any finish boundaries as required (see Figure 16).  

 
Figure 16 – Add Symbols and edit the values onscreen 

 Like other annotation, you can select the Symbol after you place it and then use the tools on the 
ribbon to add leaders if required.  

 To edit the hidden fields, select the symbol and edit its properties. Or wait till you have a schedule 
and edit there.  

 Add several Symbols and fill in various values. To add the Schedule, use the Note Block tool. On the 
View tab of the ribbon, click the Schedules tool and choose Note Block.  

 Each of the Generic Annotation Symbols in the project will be listed. Select your Finish symbol, type 
a name and then click OK.  

 In the “Note Block Properties” dialog, add all the fields. On the Sorting/Grouping tab, you can 
uncheck the “Itemize every instance” checkbox and you will end up with only one entry for each 
unique value. For example, if you want P-1, P-2 and P-3 to each be listed only once, uncheck this 
box. Further, setting it up this way allows you to easily edit the other fields associated with P-1 
directly in the Schedule rather than having to edit them individually in the project views (see Figure 17). 
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Figure 17 – Add Symbols and edit the values onscreen 

Other Tips 
There are many more topics worth discussion. Hopefully in this short tour of Revit features relevant to 
the Interior Designer, you have found some compelling reasons to give Revit some serious consideration 
for your next project. Here are a few more items/questions to consider:  

2D vs. 3D—Often people get the impression 
that in order to use Revit, they must model 
everything in 3D. I am not sure why they get 
that impression, maybe it is all the hype out 
there telling them to do everything in 3D… 
Much of what you build in Revit will be 3D. 
3D can be very useful and powerful. 
However, it is not necessary to build 
everything in 3D. Furniture and equipment 
are terrific examples. If you plan to do 
renderings of the 3D space and wish for the 
furniture to appear in the rendering, then 
you will be required to have 3D models of your furniture. But, if you are only concerned with creating 
furniture plans and schedules, 3D will not be required. When you build the Family, simply add only 2D 
geometry in plan and that is all you will see in both plan and 3D views. This is also an excellent way to 
quickly leverage your existing symbol libraries. You can literally import the AutoCAD 2D symbols directly 
into Families in Revit (see Figure 18).  

Note: Complex AutoCAD geometry in Families can impede performance. So while simply importing 
AutoCAD files directly into a Family is the fastest way to migrate a library quickly, a better long-term 
solution will be to consider converting all such AutoCAD files to native Revit 2D or 3D geometry.  

 
Figure 18 – Families can contain simple 2D symbols if 3D 
is not required 
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In-Place Families—for very custom “one-off” conditions in a project that will not be reused in other 
projects, consider In-Place Families. In-Place Families have the benefit that they are built “in-place” in 
the context of your project (see Figure 19). So you can easily take advantage of surrounding geometry to 
build them. However, they are not portable at all, so if you build one in a project, you will not be able to 
use it in another project. If you need it in another project, build a regular Family instead.  

 
Figure 19 – Example of an In-Place Family 

Moving Room Tags outside of rooms—You can move all tags to a new location. With Room Tags 
however, the Room Tag must remain inside the Room boundaries or it will lose its association. To 
overcome this, add a leader to the Room Tags.  

 
Figure 20 – To move Room Tags outside the Rooms, add a leader 

Schedules—When you choose your fields for a schedule, be sure to look at the “Select available fields 
from” drop-down list (see Figure 21). Certain object types will allow you to query fields from other 
objects. For example, when creating a furniture schedule, you can choose fields from Rooms. This will 
allow the furniture to report in which Room it is located and even list the occupant or other relevant 
data from that Room.  
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Figure 21 – Certain objects can query properties from other elements such as Rooms 

Add Rooms to a Schedule—If you have Room Schedule, you can actually add Rooms to your model 
directly from the Schedule. Such Rooms will appear on the Schedule as “Not Placed.” To do this, open a 
Room Schedule. On the ribbon, on the Rows panel, click the Insert dropdown button and choose Data 
Row. This will add a Room to the Schedule but not the model. You can fill in its name and other 
properties directly in the schedule. Later, in a plan, you can place the Room by choosing it from the 
Options Bar when adding a Room (see Figure 22).  

 
Figure 22 – Add Rooms to a Schedule and place them later 
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Further Study 
You can find more information and tutorials in The Aubin Academy Master Series: Revit Architecture.  

 

I also have Revit video training available at: www.lynda.com/paulaubin. I 
have nine courses at lynda.com: Revit Essentials (2014, 2013 and 2011), 

Up and Running with Revit, Revit Family Editor, Revit Architecture 
Rendering, Migrating from AutoCAD to Revit, Phasing and 
Design Options and Advanced Modeling in Revit Architecture.  

If you have any questions about this session or Revit in general, you can use the 
contact form at www.paulaubin.com to send me an email.  

Follow me on titter: @paulfaubin 

 
Thank you! 
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